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Ooligan Press Editorial Department  

 
June 19, 2019 

Cindy Hiday 
Iditarod Nights 
Heavy Copyedit Editorial Note 

Dear Cindy: 

It has been so exciting to work on this second round of editing for Iditarod Nights and to see all 
the changes you’ve made. You’ve obviously put a lot of time and thought into responding to our 
edits and making revisions of your own, and the manuscript has benefited substantially from 
this hard work. I’m really impressed, and I’m looking forward to seeing the manuscript become 
even more polished and perfected as we continue our work together. 

Since we’ve already done one round of editing, you know the drill. In this second editorial note, I 
will simply draw your attention to some of the broader changes that have been made or 
suggested, and then provide a few reminders about the revision process. Then you can dive into 
the updated manuscript and work your magic! 

The purpose of this heavy copyedit is twofold: to smooth out any remaining bumps in the 
storyline and dialogue that weren’t fully resolved in the first round, and to begin focusing more 
intensively on matters of language, grammar, formatting, and stylistic conventions. On the 
whole, we’re moving away from the broader narrative-based editing we undertook in the line 
edit and zeroing in on more nitty-gritty copyediting concerns. My team of editors worked hard 
to make careful decisions about which edits would best serve the manuscript, and, as always, 
I’ve personally gone over all of their suggestions to ensure accuracy and consistency. 

I’ve included an updated version of the individualized style sheet we created for this project. If 
you notice that any of the items on the style sheet haven’t been treated consistently in the 
manuscript, please feel free to bring this to my attention, but don’t be alarmed: during the next 
round of copyediting, we will devote a lot of our attention to working out any remaining kinks in 
the style sheet and ensuring that all terms are treated consistently. 

As a refresher, here is a brief overview of how we’ve made our editorial decisions: 

➢ We deferred to Merriam-Webster’s Collegiate Dictionary for most spelling and 
hyphenation choices. 

➢ All style choices were based on the seventeenth edition of The Chicago Manual of Style 
(CMOS) and feedback from the editing team. These choices include a few items I’ll 
discuss below, but also: 

o The use of commas with dependent clauses. 
o The use of italics for foreign words and phrases. 
o Spelling and formatting of temperature. 
o The use of the Oxford comma. 

 
And as always, we have used Microsoft’s Track Changes function to conduct our edits. 
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Formatting 

We focused more on formatting in this round than in the last. The most noteworthy change in 
this regard has been our decision to move away from the use of italics to represent dreams and 
flashbacks (though italics are still used to represent direct internal thoughts, as well as 
remembered dialogue in a non-flashback context). After much deliberation, Emma and I came 
to this decision based on two primary drawbacks of using italics in such cases: one, lengthy 
passages of italics are harder to read and can be fatiguing for the reader; and two, they make it 
slightly more difficult to emphasize specific lines and to represent internal thoughts and “flash-
forwards” within a dream or flashback. Additionally, setting all scenes in roman lends a more 
elegant and seamless quality to the story, and it emphasizes how—especially for a character like 
Dillon, who suffers from PTSD—flashbacks, dreams, and reality can blend together and inform 
one another. 

In every scene in which we changed italics to roman type, we took care to consider the 
surrounding context and to implement a combination of section breaks and in-text cues to 
prevent any confusion for readers. One example of this is the moose attack scene, when Dillon 
has a flashback to the police shooting. In this case, simply setting the flashback in roman 
without incorporating other textual cues would have confused readers (who would likely wonder 
why there were suddenly pizza boxes on the Iditarod Trail). So in this case, we decided it was 
most appropriate to insert section breaks before and after the flashbacks. These section breaks 
create additional suspense and gravity in this scene and strengthen the ending of the chapter, 
and they also make it clear to readers that they are being transported out of the here and now of 
the story. In other cases where we removed italics (for example, when Dillon has a nightmare at 
a checkpoint and is woken up by Claire), we found that textual cues were sufficient to keep 
readers on track, so we chose not to add section breaks. 

Another formatting change you may notice is that we have removed paragraph indentations at 
the beginnings of chapters and sections. This is fairly standard practice and shouldn’t have any 
obtrusive effect on the text. We have also formatted all ellipses as glyphs (so that each ellipsis is 
a single typographical character) upon the request of our design department. You may notice 
some formatting inconsistencies at this point (for example, different spacing before and after 
section breaks), but in general, you don’t need to worry about these matters—all formatting will 
be standardized and polished in the next round of editing and in the subsequent design process. 

 

Structure and Narrative 

As I’ve noted above, you did a fantastic job working on narrative and structure in the last round 
of editing. You’ve shown great thoughtfulness and skill in fleshing out certain scenes, expanding 
on sensory details and character emotions, adding beats of suspense where necessary, and 
smoothing out narrative issues. I was particularly impressed with your reworking of the 
conversation between Claire and Dillon on the porch in chapter 3, your expansion on the moose 
attack scene in chapter 14, and your revision of the scene in which Dillon recounts the shooting 
in chapter 25. In all of these cases (and others), you’ve found subtle yet effective solutions to the 
main narrative problems we sought to address in the first round of editing. All of these changes 
will combine to immerse your readers more deeply in the story and to give them a more 
satisfying and enriching reading experience. 

Thanks to all your hard work in the last round, you won’t need to do nearly as much rewriting 
this time—most of the narrative and structural concerns have been addressed. That said, there 
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are still a few places where we believe the story would benefit from just one more additional 
sentence or a few more words of description, and I have made note of those areas in my queries 
within the document. 

Additionally, we have paid careful attention to potential narrative inconsistencies in this round, 
and we have found a couple of places where some revision may be necessary to clear up any 
confusion in the storyline. The main example of this that I wanted to bring to your attention is a 
possible inconsistency regarding Dillon’s knowledge of Claire’s promise to her father that she 
will return to Portland after the race: although Dillon refers to this promise at the end of chapter 
21 and again more explicitly in chapter 22, we were unable to pinpoint a moment prior to this 
when Claire actually tells Dillon about this promise. Readers know about the promise, but as far 
as they can tell, Dillon has no way of knowing about it unless Claire tells him. In order to ensure 
consistency and keep readers in the minds of the characters, it will likely be necessary to add a 
few lines of dialogue earlier in the manuscript in which Claire explicitly tells Dillon about the 
promise she made to her father. Adding in such an exchange will also create an opportunity to 
increase the dramatic tension and highlight the main obstacle standing in the way of Claire and 
Dillon’s relationship. 

 

Fact-Checking 

While you were working on your revisions for the last round, a group of Ooligan fact-checkers 
(made up of members of the Iditarod Nights project team) were busy doing research to confirm 
the accuracy of all geographical and Iditarod-related information in the manuscript. As you 
know, it is ultimately the author’s responsibility to ensure factual accuracy, and there is of 
course more factual wiggle room in works of fiction. However, since this manuscript contains a 
lot of information specific to real places and events, we know that readers will appreciate and 
benefit from the highest level of accuracy possible. You have clearly done your research, and for 
the most part, our fact-checkers found that the facts stated in the manuscript were accurate; 
however, they did find a few minor discrepancies and a few things that could not be confirmed 
by their sources. In some of the simpler cases (such as discrepancies in mileage and elevation 
numbers), I have gone ahead and made adjustments within the manuscript and explained the 
changes in accompanying queries. In other cases, I have written queries explaining the 
discrepancies and deferred to your judgment and your sources. 

If you would like any specific information on the sources used by our fact-checkers, please let 
me know, and I can provide you with it. 

 

Language and Sentence Structure 

As I mentioned above, this second round of editing has drilled in more specifically on matters of 
language and stylistic conventions. As the final round of copyediting will be lighter and will 
allow less leeway for reworking sentences, this current stage is where we can really focus on 
refining and varying language and sentence structure. 

The team of editors has made note of the unique attributes of your personal style, and we have 
sought to preserve your strong writerly voice whenever possible. As Emma touched on in the last 
round, we have generally retained comma splices, sentence fragments, and less conventional 
word usages in all cases where they serve the manuscript (which they often do to great effect) 
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and do not interfere with reader comprehension. In cases where clarity has potentially been 
compromised, we have reworked sentences or queried with possible fixes. We have also flagged 
repetitions of words and phrases to ask whether they are intentional and to suggest potential 
replacements for the sake of variety. 

After the last round, you expressed a concern about the use of the past perfect tense 
(characterized by our introduction of the word had at various points in the manuscript). The 
proper use of the past perfect is tricky (especially in a manuscript that includes so many 
references to past events), and you’re absolutely right that its overuse or misuse can be intrusive 
and even disorienting for readers. In light of your comments, I have taken extra care to look 
closely at the ways in which verb tenses are operating in the manuscript and to not allow any 
more past perfect to creep in unless I felt it was necessary to reader comprehension and the flow 
of the text. There are, of courses, places where we need to use the past perfect to make it clear to 
readers that we aren’t referring to an event that is happening in the here and now of the story, so 
I have re-implemented it in a few places during this round (sometimes with an accompanying 
explanation). However, please let me know of your concerns about specific instances of past 
perfect usage, and in the next round we will work on finalizing the tenses in order to give readers 
the smoothest reading experience possible. 

 

Revision Process 

Just as a reminder, when reviewing the corresponding manuscript document (“Iditarod Nights 
Full MS – Heavy Copyedit 2.doc”), you will likely find it helpful to toggle between “All Markup” 
(to see exactly what we have changed) and “Simple Markup” (to see the clean manuscript with 
our edits implemented, along with marginal queries). Make sure that Track Changes is always 
turned on so that all of your edits are recorded. 

When you make edits to the manuscript, it will be helpful to our editors if you ensure that smart 
quotes are turned on (quotes and apostrophes should appear as curly, like “ and ’, as opposed to 
straight, like " and '). Depending on what version of Word you are using, you should most likely 
be able to turn on smart quotes by following these steps: File > Options > Proofing > 
AutoCorrect Options > AutoFormat as You Type > Replace straight quotes with smart quotes 
(check box). If you have any difficulty turning smart quotes on, feel free to contact me and we 
can try to problem-solve together. 

After you finish accepting/rejecting our edits and making any of your own, please send the 
updated file back to me. 

As always, don’t hesitate to reach out with any questions or concerns during the revision 
process! 

 

All the best, 

Olivia Rollins 
Copy Chief 
Ooligan Press 
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Word and Style Consistency List 

A–C 
air taxi (not air-taxi) 
all right (not alright) 
Alaska Range (not Alaskan Range) 
(tri-colored) Alaskan husky (not Husky) 
Alpine Annie 
Andy Sommer 
Athabascan 
ax (not axe) 
backward (no s) 
Bagby Hot Springs 
bale (not bail) 
barbecue (not barbeque or barbecued) 
batwing (not bat-wing) 
Bering Sea 
Bering West 
bedlam 
Big River 
Blackie 
blond (not blonde) 
Bonnie 
Brian Warren 
broad-chested 
brush bow (not brushbow) 
Buffalo Tunnels 
Burled arch 
calloused (not callused) 
Campbell Airstrip 
Caroline Stanfield 
cauldron (not caldron) 
Chevron 
Cheechako 
Chugach Mountains 
Claire Stanfield 
clench (not clinch) 
Clyde 
cookhouse 
coffee maker (not coffeemaker) 
country scrambled eggs (not country-
scrambled eggs) 

D–F 
Daisy 
Dalzell Gorge/Dalzell Creek 
deiced (not de-iced) 
Deshka 
Dillon Cord 
Dodge 
doghouses (not dog houses) 
Elliot 
Elim 
Ethan Stanfield 
Farewell Burn 
Flannigan's Stew (Stewie) 
fluorescent (not florescent) 

G–I 
Galena 
gangline (not gang line) 
George 
Ginny 
god-awful (not God-awful) 
goddamn 
Golovin Lagoon 
good-looking (hyphenated when preceding a 
noun) 

J–L 
Jack Daniel’s (not Jack Daniels) 
Janey Sommer 
Kaltag 
Klondike 200 
Knik River 
Koyuk 
Kristi 
Kuskokwim River 
Kwik River 
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gonna (short for going to) 
Grant Hamilton 
Gretchen 
Groucho 
Guy 
Handsome 
hand warmers 
Hammertown (wrong surname Andy gives 
Grant) 
Happy River 
Happy River Steps 
Happy River Canyon 
Harmony  
HEET (brand name-fuel) 
Helen Warren 
hon (not hun, term of endearment, short for 
honey) 
Hup 
IditaRider 
IditaRides 
IditaShoots 
Iditarod Trail (capitalized) 
Iditarod Trail Committee (spell out, not ITC) 
interior Alaska (interior is lowercased) 

the Last Frontier (capitalized when used as a nickname for Alaska) 
laundromat (not Laundromat) 
leave of absence (not leave-of-absence) 
light-headed (not lightheaded or light headed) 
lineup (not line-up) 
Little McKinley 

M–O 
malamute (lowercase) 
Mama’s Boy 
Matt Sommer 
Matchsticks 
matchmaker 
Maverick 
Max 
McGrath 
midbite (not mid bite) 
midmorning (not mid-morning) 
midnote (not mid note) 
midsentence (not mid sentence) 
midtap (not mid tap) 
Mingo 
mini-mall (not minimall or mini mall) 
Mount McKinley 
mukluks 
Mulcahy Stadium 
multicolored (not multi-colored) 
neck line (not neckline) in dog race context 
Nikolai 
Nome 
Nome-Council Road 
northern lights (lowercase) 
Norton Bay 
notepaper (not note paper) 
Nulato 
offhanded 

P–S 
partyer (not partier) 
Pepper 
Pete 
peanut (when used as term of endearment) 
pickaxes 
power line 
Portland 
Rainy Pass 
Ranger 
Riley 
Rocky 
Rohn checkpoint 
roller-coaster (not roller coaster) when adjective 
Sam 
self-conscious 
self-assurance 
self-importance 
Shaktoolik 
ski poling (not ski-poling) 
Skwentna 
Siberian husky 
sideslipped (not side-slipped) 
sing-alongs (not sing-a-longs) 
Singer 
smart-ass (not smartass) 
snack (okay to use as a transitive verb, as in “she stopped trailside to 
snack her athletes”) 
snow hook (not snowhook) 
snow machine (not snowmachine or snowmobile) 
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Old Woman Cabin (all three words 
capitalized) 
overheated (not over-heated) 

snub line (not snubline) 
someday (not some day) 
Sommer Kennels 
South Fork Kuskokwim River (not Kuskokwim River’s South Fork) 
spiraled (not spiralled) 
stake-out chains (not stake chains) 
street-side (hyphenated when used adjectivally before a noun) 
Sugar 
Susitna River  

T–V 
Takotna 
Talkeetna 
Tatina River 
Ted Warren 
Teller 
Texas Two-Step (not Texas Two Step) 
Toolik 
toboggan 
Topkok River 
top-notch (not topnotch) 
traveling (not travelling) 
Treker 
tricolored (not tri-colored) 
Trouble 
tug line (not tugline) 
tag sled 
turnoff (not turn-off) 
uh-huh (not uh huh) 
Unalakleet 
US mail (not U.S.) 

W–Z 
Wasilla 
White Mountain 
Willow 
Willow-Tug 300 
Windy 
Willamette 
Wood-burning stove 
woodsmoke (not wood smoke) 
woof (not whuff) 
Wurlitzer 
Yentna River 
Yukon 
Zach 

 


